## Canon Utilities

- Digital Photo Professional Ver.2.0

## Table of Contents

1. Displaying Thumbnail Images and Performing Basic Edits in the Main Window
2. Performing Detailed Edits in the Edit Window
3. Performing Detailed Edits in the Edit Image Window
4. Displaying an Image in the Quick Check Window
5. Reference

## Compatible Models

- EOS-1D Mark II N
- EOS-1Ds Mark II
- EOS-1D Mark II
- EOS-1Ds
- EOS-1D
- EOS 5D
- EOS DIGITAL REBEL XT/350D DIGITAL
- EOS 20D
- EOS DIGITAL REBEL/300D DIGITAL
- EOS 10D
- EOS D60
- EOS D30
- PowerShot Pro1

## Index
NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate without notice to you if you fail to comply with any of the terms of this Agreement and you must then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with restrictions. Use, duplication or disclosure is subject to restrictions as set forth in either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in the United States of America shall be governed and construed in all respects in accordance with the laws and regulations of the State of New York, without reference to choice of law principles. The terms of this Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of the SOFTWARE is subject to the United States, Canada and other applicable copyright and trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its affiliated corporations and third party licensors under such laws. Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any images, graphics or textual material that you save in connection with the Software.

10. ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
Introduction

This chapter includes information on the precautions to be read before using Digital Photo Professional, how to use this Instruction Manual, the system requirements and the supported image types. It also explains the functions and window structure, and gives examples of operation.

About This Manual

Thank you for purchasing this Canon product. Precautions for using this product safely and icons to help you with procedures, etc. are described at the beginning of this Instruction Manual. Please be sure to read these first before proceeding to the information in the other chapters.

- It is prohibited to reproduce, in whole or part, the contents of this Instruction Manual without permission.
- Canon may change without notice the software specifications and contents of this Instruction Manual.
- The software screens and displays printed in this Instruction Manual may differ slightly from the actual software.
- The content of this Instruction Manual has been reviewed thoroughly. However, if you should notice any errors or omissions, please contact a Canon Service Center.
- Please note that irrespective of the above-mentioned, Canon does not take responsibility for the outcome of the operation of the software.

Safety Precautions

Please read the safety precautions carefully before using this product. Ensure that you use the product correctly according to the procedures described in these instructions. The following safety precautions are intended to instruct you in the safe and correct operation of the product and its accessories to prevent injuries or damage to yourself, other persons and property. Please read and ensure that you understand them before you proceed to the other sections of these instructions.

Trademark Acknowledgments

- Canon and EOS are trademarks of Canon Inc.
- IBM is a registered trademark of International Business Machines Corporation.
- Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- Adobe and Photoshop are registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
- Other names and products not mentioned above may be registered trademarks or trademarks of their respective companies.

How to Read the Manual and the Conventions Used

- In this manual, Windows XP Professional/Home Edition is referred to as “Windows XP”, and Windows 2000 Professional is referred to as “Windows 2000”.
- In this manual, the screens used in the examples are from Windows XP.
- In this document, square brackets [ ] are used to indicate items such as window names, menu names and button names that appear on the computer screen.
- Text inside < > in this document indicates the key on the keyboard and camera button names.
- Asterisk in (p. *-* ) in this document shows reference pages.
- in this document indicates the sequence of operation as shown on the right.
- The explanations given below describe the type of content indicated by the respective icons.

Warning

Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support data CD-ROMs. The extremely loud sound that may result from playing the CD-ROM(s) in an audio CD player (music player) could damage the speakers. It is also possible to suffer hearing losses from listening with headphones to the loud sounds of a data CD-ROM played on a music CD player.

Trademark Acknowledgments

- Canon and EOS are trademarks of Canon Inc.
- IBM is a registered trademark of International Business Machines Corporation.
- Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
Main Features

Digital Photo Professional (DPP) software is designed for editing RAW images shot with Canon digital cameras and has the following features and functions to meet the requirements of professional and high-end amateurs who mainly shoot RAW images.

High-speed processing of RAW images

- DPP has made possible, using Canon's own high performance algorithm, high-speed processing and high-speed display of RAW images.
- DPP, Canon's genuine software, has made possible high-image quality processing.

Operation and window variety that can respond to a professional's workflow

- DPP's operation is easy, compatible with the workflow of a professional, and has a variety of function windows.
- In the main window, images can be displayed as a list (thumbnail image display), selected, rearranged, and basic editing can be performed.
- In the edit image window, one of multiple images can be selected and enlarged, checked, and detailed editing can be performed.
- In the edit window, one image can be enlarged, checked, and detailed editing can be performed.
- In the quick check window, images can be displayed one after the other, checked and selected.

Real-time image editing

- DPP has various image editing functions where the results of editing are reflected in an image in real-time.
- You can adjust all image editing functions with 16 bit high precision.
- DPP can perform various kinds of image editing with the RAW image adjustment function that is richer and has a larger degree of freedom than the image adjustment features of the camera. It also has the RGB image adjustment function that can edit RAW images and RGB images (JPEG images, TIFF images). There is almost no image deterioration of RAW images edited with the RAW image adjustment function.
- RAW image adjustment features:
  - Brightness adjustment, white balance adjustment, Picture Style setting
  - RAW image and RGB image (JPEG images, TIFF images) adjustment features:
    - Tone curve adjustment, color adjustment, sharpness, trimming, image correction (repair, copy stamp), image rotation (90° to the left or right).
  - DPP can save, import or apply recipe data (results of various adjustments made to an edited image) to other images.
  - The before and after editing comparative display function allows you to compare and adjust an image displayed in a window showing the before and after versions.

A diversity of functions

- DPP can select and organize images using 3 kinds of check marks.
- DPP can send one image to Photoshop or a batch of multiple images to optional image editing software.
- DPP can print single copies of compatible images including RAW images.

Together with Easy-PhotoPrint and Canon BJ printers, DPP can print compatible images including RAW images simply and in high quality.

DPP can convert and save RAW images as TIFF or JPEG images and attach an ICC profile.

DPP can convert and save a batch of multiple RAW images (batch processing).

DPP can change a batch of file names (rename function).

Together with EOS Capture, DPP is compatible with remote shooting.

Color management

- DPP is compatible with Color Management System.
- DPP is compatible with 5 kinds of color space (sRGB, Adobe RGB, Wide Gamut RGB, Apple RGB, ColorMatch RGB).
- DPP can attach ICC profiles to a saved image.
- DPP can set monitor and printer profiles.

With the CMYK simulation function, DPP can simulate the color of an image when printed with a printer, etc. in a CMYK environment.

System Requirements

<table>
<thead>
<tr>
<th>OS</th>
<th>Windows XP (Professional/Home Edition), Windows 2000 Professional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>PC with one of the above OS preinstalled</td>
</tr>
<tr>
<td></td>
<td>* Upgraded machines not supported</td>
</tr>
<tr>
<td>CPU</td>
<td>750MHz Pentium III or higher</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum 512MB</td>
</tr>
<tr>
<td>Hard disk space</td>
<td>256MB or more</td>
</tr>
<tr>
<td>Display</td>
<td>Screen resolution: 1024 × 768 pixels or more</td>
</tr>
<tr>
<td></td>
<td>Color quality: Medium (16 bit) or more</td>
</tr>
</tbody>
</table>

Supported Images

This software supports the following image types.

<table>
<thead>
<tr>
<th>Image type/ Camera used</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAW images: EOS-1D Mark II N, EOS-1Ds Mark II, EOS-1D Mark II, EOS 5D, EOS DIGITAL REBEL XT/350D DIGITAL or EOS 20D</td>
<td>.CR2</td>
</tr>
<tr>
<td>EOS-1Ds, EOS-1D</td>
<td>.TIF</td>
</tr>
<tr>
<td>EOS DIGITAL REBEL/300D DIGITAL, EOS 10D, EOS D60, EOS D30 or PowerShot Pro1*</td>
<td>.CRW</td>
</tr>
<tr>
<td>JPEG images: Exif 2.2 or 2.21-compatible JPEG or JFIF images</td>
<td>.JPG, .JPEG</td>
</tr>
<tr>
<td>TIFF images: Exif-compatible TIFF images</td>
<td>.TIF, .TIFF</td>
</tr>
</tbody>
</table>

*You cannot edit with the Digital Photo Professional RAW image editing function.
Digital Photo Professional comprises the windows and function windows shown below, centering on the main window that is displayed when DPP starts up.

**Main window**
- Images can be displayed as thumbnails, and basic image editing can be performed (p.1-2).
- The size of images and the way images are displayed can be changed or images can be sorted according to a selected condition (p.1-5).
- Images can be sorted and organized using 3 kinds of check marks (p.1-2).
- For RAW images, white balance and brightness can be adjusted, and color space can be set (p.1-6 to p.1-9).
- RAW, JPEG and TIFF images can be rotated (p.1-2, p.1-9).
- RAW images can be converted into JPEG and TIFF images, and edited images can be saved as separate images* (p.1-15).
- Images (including RAW images) can be printed* (p.1-19).
- All settings for Digital Photo Professional can be made* (p.1-20).

* This can also be done in the edit window and the edit image window.

**Edit image window**
- One image can be selected from multiple images and detailed editing can be performed (p.3-1).
- The size of images and the way images are displayed can be changed, or a comparison of an image before and after editing can be displayed (p.2-3).
- For RAW images, brightness and white balance can be adjusted, and Picture Style can be set (p.2-3 to p.2-6).
- Tone curve and color can be adjusted for RAW, JPEG and TIFF images (p.2-6 to p.2-8).

**Quick check window**
- Images selected in the main window can be quickly displayed in a separate window and viewed (p.4-1).
- Images can be sorted and organized using 3 kinds of check marks (p.4-1).

**Rename window**
- A batch of file names can be changed (p.1-17).

**Trimming window**
- An image can be trimmed within your desired range (p.1-10).

**Copy Stamp window**
- An image can be corrected so that unwanted spots in the image blend with surrounding color (p.1-11).
- An image can be corrected by pasting a section copied from another part of the same image to an unwanted part of the image (p.1-12).

**Tools menu**

**Switch**

**Double-click**

**Window for batch conversion and saving of images (batch processing)**
- A batch of multiple RAW images can be converted and saved to JPEG or TIFF images, and a batch of edited images can be saved as separate images (p.1-16).

**Importing images from EOS Capture**
- With EOS Capture, images shot remotely can be displayed (p.1-19).

**Transferring images to image editing software**
- Multiple images can be transferred to optional image editing software (p.1-18).

**Printing with Easy-PhotoPrint**
- Images can be printed together with Easy-PhotoPrint on Canon BJ printers (p.1-19).

**Transferring an image to Adobe Photoshop**
- One image can be transferred to Adobe Photoshop (p.1-18).
Example of Operation

The following shows typical flows of operating Digital Photo Professional.

### Example 1: Displaying Thumbnail Images and Performing Basic Edits in the Main Window

2. Display images in the main window (p.1-2).
4. Select an image and perform basic edits (p.1-6, p.1-9).
5. Print the images (p.1-19).
6. Transfer images to image editing software (p.1-18).

### Example 2: Selecting One Image from Multiple Images and Performing Detailed Edits on the Image in the Edit Image Window

2. Select multiple images in the main window (p.1-2).
3. Switch to the edit image window (p.3-1).
4. Select one image from multiple images (p.3-1).
5. Edit the image (p.2-3, p.2-6).
6. Display the image as a comparison of before and after editing (p.2-3).
7. Print the image (p.1-19).
8. Transfer images to image editing software (p.1-18).

### Example 3: Performing Detailed Edits in the Edit Window

2. Select an image in the main window (p.1-2).
3. Display the image in the edit window (p.2-2).
4. Edit the image (p.2-3, p.2-6).
5. Print the image (p.1-19).
7. Save edits (recipe data) to the image (p.1-13). Convert and save the edited image as a separate image (p.1-15).

### Example 4: Checking Images in the Quick Check Window

2. Select multiple images in the main window (p.1-2).
3. Display the images in the quick check window (p.4-1).
4. Check the images. ... Set a check mark to an image (p.4-1).

### Example 5: Applying the Editing Data (recipe data) of an Edited Image to Another Image

2. Select the edited image in the main window (p.1-2).
3. Copy the editing data (recipe data) (p.1-13).
4. Select the image to which the editing data will be applied in the main window.
5. Apply the editing data to the selected image (p.1-13).

### Example 6: Remote Shooting with EOS Capture

1. Connect the camera to your computer and turn the camera on.
2. Start up Digital Photo Professional (p.1-2).
3. Switch to the main or edit image window (p.1-2, p.3-1).
5. Take a shot by clicking the [Shoot] button in EOS Capture or pressing the shutter button on the camera.
6. Check the image, which is displayed in the main or edit image window.
1 Displaying Thumbnail Images and Performing Basic Edits in the Main Window

This chapter describes the functions of the main window, and how to display images and perform basic edits on them.

- Click on the item to display its page.

**Starting up Digital Photo Professional** ............................................................. 1-2

**Displaying Images** .................................................................................. 1-3

**Handling the Folders** .............................................................................. 1-4
  - Creating a New Folder ............................................................................ 1-4
  - Registering Frequent Use Folders with the Bookmark ......................... 1-4
  - Organizing Bookmarks ......................................................................... 1-4
  - Copying/Moving an Image ..................................................................... 1-5

**Deleting Images** .................................................................................... 1-5

**Selecting the Image Display Mode** .......................................................... 1-5
  - Selecting the Thumbnail Size .................................................................. 1-5
  - Image with Information Display ............................................................ 1-5
  - Sorting Images ....................................................................................... 1-5
  - Displaying Image Information .............................................................. 1-6
  - Displaying the Edit Window .................................................................. 1-6
  - Displaying the Edit Image Window ....................................................... 1-6
  - Displaying the Quick Check Window ................................................... 1-6

**Editing RAW Images** ............................................................................. 1-6
  - Adjusting the White Balance .................................................................. 1-6
  - Click White Balance Function ................................................................ 1-8
  - Adjusting the Brightness ....................................................................... 1-9
  - Specifying Color Space ......................................................................... 1-9

**Editing Images** ...................................................................................... 1-9
  - Adjusting the Brightness ....................................................................... 1-9
  - Trimming an Image ................................................................................ 1-10
  - Correcting an Image .............................................................................. 1-11

**Using Edits (Recipe Data)** ..................................................................... 1-13
  - Saving the Recipes ................................................................................. 1-13
  - Loading and Pasting Recipes ................................................................ 1-13
  - Copying Recipes and Applying to Other Images ...................................... 1-13

**Reverting Edited Images to Their Original Condition** .......................... 1-14
  - Reverting to Last Saved Settings ......................................................... 1-14
  - Reverting to Shot Settings .................................................................... 1-14

**Saving Edited Images** .......................................................................... 1-14
  - Saving by Overwriting ......................................................................... 1-14
  - Saving and Renaming ........................................................................... 1-14
  - Adding a Thumbnail of the Image .......................................................... 1-14
  - Converting and Saving RAW Images while Renaming Them ............... 1-15
  - Converting and Saving Images in a Single Operation (Batch-processing) 1-15

**Changing File Names in a Single Operation** ........................................ 1-17

**Transferring Images to Image Editing Software** ................................. 1-18
  - Transferring One Image to Photoshop ............................................... 1-18
  - Transferring Multiple Images to Image Editing Software ................. 1-18

**Printing Images** ................................................................................... 1-19
  - Printing with Easy-PhotoPrint ............................................................. 1-19

**Displaying Images in EOS Capture** ..................................................... 1-19

**Specifying Preferences** ........................................................................ 1-20
Starting up Digital Photo Professional

Double-click the [Digital Photo Professional] icon on the desktop.

- The main window is displayed.
- Alternatively, you can start up Digital Photo Professional by clicking the [Start] button ➤ select [All Programs] ➤ [Canon Utilities] ➤ [Digital Photo Professional] ➤ [Digital Photo Professional].

For information on shortcut keys, refer to the "Shortcut List" (p.5-2).
**Information Displayed with Images**

The following shows the information displayed when [Large thumbnail] (p.1-5) is selected.

- This mark is displayed for images being trimmed (p.1-10).
- This mark is displayed when a check mark is set (p.1-2, p.4-1).
- This value is displayed for RAW images for which the brightness was adjusted (p.1-9).
- The icon for the specified white balance is displayed with RAW images only (p.1-7).
- The [RAW] symbol is displayed for RAW images. (When [Small thumbnail] is selected, the [R] symbol is displayed). No symbol is displayed for JPEG and TIFF images.
- This mark is displayed for images for which the RGB processing (p.1-9, p.2-6) was performed.
- This mark is displayed for images which were shot with the camera held vertically with [Auto rotate] setting to <ON> are automatically displayed vertically.
- This mark is displayed for unsaved images being edited.
- This mark is displayed for an image that has been corrected with the copy stamp tool (p.1-11, p.1-12).
- The aperture value used when images were shot is displayed.
- The shutter speed used when images were shot is displayed.
- This mark is displayed for images being trimmed (p.1-10).

**Displaying Images**

You can display images saved on your computer in the main window.

1. Click the folder in which images are saved.

**Note:**
- You cannot display images saved on a memory card in the camera. You must save images to your computer using other software supplied with the camera or a third-party card reader.
- A JPEG image set to Adobe RGB and taken with the EOS 10D, EOS DIGITAL REBEL/300D DIGITAL or PowerShot Pro1 may display with the sRGB color space applied.
- Images that cannot be displayed appear as [X].
- Images that were shot with the camera held vertically with [Auto rotate] setting to <ON> are automatically displayed vertically.
- You can display images saved on a memory card using a third-party card reader.

Refer to "Supported Images" for information about the images that can be displayed (p.0-2).

- Images that cannot be displayed appear as [X].
- Images that were shot with the camera held vertically with [Auto rotate] setting to <ON> are automatically displayed vertically.
- You can display images saved on a memory card using a third-party card reader.
Handling the Folders

You can handle the folder on the menu that appears by right-clicking the folder.

Right-click on the folder and select an option from the menu that appears.
- You can drag and drop folders in the folder area to move them to the other folders. You can also copy the folders by dragging and dropping them while holding down the <Ctrl> key.

Creating a New Folder

You can create a new folder in the folder area.

1. In the folder area, select the location where the new folder is to be created.
2. Select the [File] menu ➤ [Create new folder]. ➤ The [Create new folder] dialog box appears.
3. Enter a folder name. ➤ The folder is created.

Registering Frequent Use Folders with the Bookmark

You can register frequent use folders with the [Bookmark] menu.

1. Select a folder in the folder area.
2. Select [Bookmark] menu ➤ [Add]. ➤ The selected folder is registered with the [Bookmark] menu.
   - The registered folder can be selected from the [Bookmark] menu.

Organizing Bookmarks

You can change the name of the folder or delete the folder that was registered with the [Bookmark] menu.

   - The path and name of the folder that is selected in the bookmark folder area is displayed.

Creating a New Folder

You can create a new folder in the folder area.

1. In the folder area, select the location where the new folder is to be created.
2. Select the [File] menu ➤ [Create new folder]. ➤ The [Create new folder] dialog box appears.
3. Enter a folder name. ➤ The folder is created.

Registering Frequent Use Folders with the Bookmark

You can register frequent use folders with the [Bookmark] menu.

1. Select a folder in the folder area.
2. Select [Bookmark] menu ➤ [Add]. ➤ The selected folder is registered with the [Bookmark] menu.
   - The registered folder can be selected from the [Bookmark] menu.

Organizing Bookmarks

You can change the name of the folder or delete the folder that was registered with the [Bookmark] menu.

   - The [Sort bookmarks] dialog box appears.

Creating a New Folder

You can create a new folder in the folder area.

1. In the folder area, select the location where the new folder is to be created.
2. Select the [File] menu ➤ [Create new folder]. ➤ The [Create new folder] dialog box appears.
3. Enter a folder name. ➤ The folder is created.
Copying/Moving an Image
You can copy and save an image to another folder.

1. Select the image to be copied or moved.
2. Select the [Edit] menu ▶ [Copy] or [Cut].
   ▶ The image is copied or cut.
3. Select the folder to which the image is to be saved or moved.
4. Select the [Edit] menu ▶ [Paste].
   ▶ The image is copied or moved to the selected folder.

Deleting Images
You can move unnecessary images to the Recycle Bin on your computer and delete them.

1. Select images and then select [File] menu ▶ [Delete].
   ▶ The [Confirm File Delete] dialog box appears.
   ▶ If you select multiple images, the [Confirm Multiple File Delete] dialog box appears.
2. Click the [Yes] button.
   ▶ The images are moved to the Recycle Bin.
   ▶ The images are deleted.

**Note:**
- Images that you deleted in step 3 cannot be restored. Check carefully before deleting images.
- When multiple images are selected, all the selected images will be deleted. Take particular care when you have just finished a task involving the selection of multiple images.

Selecting the Image Display Mode
You can change the size or method and sort images according to a selected condition.

Selecting the Thumbnail Size
The available image sizes are [Large thumbnail], [Middle thumbnail], and [Small thumbnail].
Various information (p.1-3) is displayed in the display frame.

1. Select [View] menu ▶ Select the size to be set.
   ▶ The images are displayed in the selected size.

Image with Information Display
You can display the brightness histogram and the shooting information for images.

1. Select [View] menu ▶ [Thumbnail with information].
   ▶ The images with attached information are displayed.

Sorting Images
You can sort images according to a condition you select.

1. Select [View] menu ▶ [Sort] ▶ Select the condition to be set.
   ▶ The images are sorted according to the selected condition.

   - **[File name]**: File names are sorted in alphanumeric order (0 to 9 → a to z).
   - **[RAW priority]**: Displayed in the following order:
     - RAW images (CR2 → CRW → TIF) → RGB images (JPG → TIF)
     - If multiple images have the same extension, they are sorted in order of [File name].
   - **[Check mark1]**: Displayed in the following order:
     - check-marked images with selected number → check-marked images with other numbers → images without check marks
     - If multiple images have the same check mark number, they are sorted in order of [File name].
   - **[Shooting Date/Time]**: Sorted by shooting date and time. If multiple images were taken on the same date and time, they are sorted in order of [File name].

In addition to [CRW_YYYY.CRW] (RAW images) and [IMG_YYYY.JPG] (JPEG images),
[CRW_YYYY.THM] (images for displaying camera indexes) is saved in the folder
[xxxCANON] where images you have taken with the EOS 10D, EOS DIGITAL REBEL/300D DIGITAL, EOS D60, EOS D30 and PowerShot Pro1 are saved. With Digital Photo Professional, [CRW_YYYY.THM] images are not displayed and therefore you cannot move or delete them. Move or delete [CRW_YYYY.THM] images on the Explorer.
[xx] of folder names and [YYYY] of image names represent a number.
Displaying Image Information

You can check various information for images.

Select an image and then select [File] menu ➤ [Info].
- The image information appears.
- Clicking the [Close] button closes the dialog box.

Image information may not appear for JPEG images set to Adobe RGB and shot with the EOS 10D, EOS DIGITAL REBEL/300D DIGITAL or PowerShot Pro1.

Displaying the Edit Window

You can enlarge the image and perform detailed edits.

Double-click an image.
- The edit window appears.
- See Chapter 2 “Performing Detailed Edits in the Edit Window” for the information on the edit window.

Displaying the Edit Image Window

You can select one image from multiple images and perform detailed edits.

Select multiple images and then click the [Edit image window] button.
- The main window switches to the edit image window.
- See Chapter 3 “Performing Detailed Edits in the Edit Image Window” for the information on the edit image window.

Displaying the Quick Check Window

You can individually display images in a larger size and can quickly view and check each image.

Select multiple images and then select the [Tools] menu ➤ [Start Quick check tool].
- The quick check window appears.
- See Chapter 4 “Displaying an Image in the Quick Check Window” for the information on the quick check window.

Editing RAW Images

You can perform various edits on the RAW images that are supported by Digital Photo Professional. With RAW image editing (p.1-6 to p.1-9), there is hardly any of the deterioration which accompanies image editing. You can therefore edit an image multiple times while preserving the image quality at the time the image was shot.

1. Select a RAW image.
2. Edit the RAW image (p.1-6 to p.1-9).
   - You can apply edits to other images by copying and pasting the edit data to the other images (p.1-13).
   - You can revert edited images to the last saved settings or shot settings (p.1-14).
3. Save the edited image (p.1-14).
   - You cannot edit PowerShot Pro1 RAW images.
   - Before exiting Digital Photo Professional, you must save the edited images (p.1-14).
   - When multiple images are selected, the edits are applied to all the selected images.
   - The editing data can be saved in a separate file (p.1-13).
   - The edited images can be transferred to image editing software (p.1-18).

Adjusting the White Balance

You can set the white balance with each method.

   - The [White balance adjustment] dialog box appears.
   - Alternatively, you can display this dialog box by selecting [Adjustment] menu ➤ [White Balance].
2. Adjust the white balance by making each setting (p.1-7, p.1-8).
3. Click the [Close] button.
Selecting the White Balance
You can specify the white balance.

**Select the white balance from the list box.**

<table>
<thead>
<tr>
<th>White Balance</th>
<th>Details</th>
<th>Color Temp. K (Kelvin)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shot settings</td>
<td>To apply the white balance setting used when the shot was taken.</td>
<td>—</td>
</tr>
<tr>
<td>Auto</td>
<td>Automatically adjusts the white balance.</td>
<td>Approx. 3000 to 7000</td>
</tr>
<tr>
<td>Daylight</td>
<td>For sunny daylight outdoors.</td>
<td>Approx. 5200</td>
</tr>
<tr>
<td>Shade</td>
<td>For shaded areas outdoors.</td>
<td>Approx. 7000</td>
</tr>
<tr>
<td>Cloudy</td>
<td>For cloudy or hazy days and during sunset.</td>
<td>Approx. 6000</td>
</tr>
<tr>
<td>Tungsten light</td>
<td>For tungsten (light bulb) light.</td>
<td>Approx. 3200</td>
</tr>
<tr>
<td>Fluorescent light</td>
<td>For white fluorescent light.</td>
<td>Approx. 4000</td>
</tr>
<tr>
<td>Flash</td>
<td>When flash is used.</td>
<td>Approx. 6000</td>
</tr>
<tr>
<td>Color temp.</td>
<td>You can manually set color temperature for 2800 to 10000K (in 100K increments).</td>
<td>Approx. 2800 to 10000</td>
</tr>
<tr>
<td>Click white balance</td>
<td>Displayed for images on which you performed the click white balance.</td>
<td>—</td>
</tr>
</tbody>
</table>

Specifying the Color Temperature
You can specify the color temperature in the range of 2800 to 10000K (in 100K increments).

1. Select [Color temp.] from the list box.

2. Adjust an image while viewing it.

   - Drag the slider left or right to adjust the color temperature.
   - The adjusted value appears.
**Adjusting with the Color Wheel**

You can select a desired color from the color wheel. You can also specify the hue in the range of 0 to 359 (in 1-stop increments), and the saturation in the range of 0 to 255 (in 1-stop increments).

1. **Click the [Tune] button.**
   - The color wheel appears.

2. **Adjust an image while viewing it.**
   - Drag [ ] to adjust an image.

**Personal White Balance**

You can apply the personal white balance (p.2-4) that you registered in the edit window or the edit image window to images.

- **Click the [1], [2] or [3] button.**
  - The registered personal white balance is applied to the image.

- **You cannot use the personal white balance if you have not registered it.**

**Click White Balance Function**

Makes white the standard for the point you selected and color in the image is adjusted.

1. **Click the [Click (RAW)] button (p.1-2).**
   - When you move the cursor over the image, the cursor [ ] changes to [ ].

2. **Click the point where is to be the standard.**
   - The color in the image is adjusted with white as the standard on the point you selected.
   - If you click on another point over the image, the white balance is adjusted again.
   - When you finish this operation, click the [Click (RAW)] button or right-click.

- **The coordinates of the cursor position and the RGB values (8-bit conversion) of the image are displayed in the lower-left of the main window (p.1-2).**
- **The image is adjusted based on the value of 1 × 1 pixels from the clicked point.**
- **Even if you have selected a neutral gray point of the image, the result of adjustments is the same as when you select a white point.**
**Adjusting the Brightness**

You can adjust the brightness in the range of –2.0 to +2.0 (in 0.01-stop increments when entering a value).

1. **Click the [Brightness (RAW)] button (p.1-2).**
   - The [Brightness adjustment] dialog box appears.
   - Alternatively, you can display this dialog box by selecting [ Adjustment] menu ➤ [Brightness adjustment (RAW)].

2. **Adjust an image while viewing it.**

   ![Brightness adjustment dialog box](image)

   - Drag the slider left or right to adjust the brightness.
   - Enter a value to adjust the brightness.
   - Restores the image to its original settings.

3. **Click the [Close] button.**

**Specifying Color Space**

You can set a color space other than the one set in [Default settings of Work color space] in the preferences (p.1-21).

- **Select [ Adjustment] menu ➤ [Work color space] ➤ Select a color space to be set.**
  - The selected color space is set.

The specified color space is added to the ICC profile that is embedded in TIFF or JPEG images that have been converted from RAW images and saved (p.1-15, p.1-16). A color space is the reproducible color range (the characteristics of color gamut). Digital Photo Professional supports the following 5 kinds of color space:

- **sRGB**: Standard color space for Windows. Widely used for the standard color space of monitors, digital cameras, and scanners.
- **Adobe RGB**: A wider color space than sRGB. Mainly used for printing for business purposes.
- **Wide Gamut RGB**: A wider color space than Adobe RGB.
- **Apple RGB**: Standard color space for Macintosh. A slightly wider color space than sRGB.
- **ColorMatch RGB**: A slightly wider color space than sRGB. Mainly used for printing for business purposes.

**Editing Images**

You can perform various edits on the RAW, JPEG, and TIFF images that are supported by Digital Photo Professional.

1. **Select an image.**

2. **Edit the image (p.1-9 to p.1-12).**
   - You can apply edits to other images by copying and pasting the edit data to the other images (p.1-9).
   - You can revert edited images to the last saved settings or shot settings (p.1-14).

3. **Save the edited image (p.1-14).**

   - Before exiting Digital Photo Professional, you must save the edited images (p.1-14).

   - When multiple images are selected, the edits are applied to all the selected images.
   - The editing data can be saved in a separate file (p.1-13).
   - The edited images can be transferred to image editing software (p.1-18).

**Adjusting the Brightness**

You can adjust the brightness of an image in the range of –100 to +100 (in 1-step increments when entering a value).

1. **Select [ Adjustment] menu ➤ [Brightness adjustment].**
   - The [Brightness adjustment] dialog box appears.

2. **Adjust an image while viewing it.**

   ![Brightness adjustment dialog box](image)

   - Drag the slider left or right to adjust the brightness.
   - Enter a value to adjust the brightness.
   - Restores the image to its original settings.

3. **Click the [Close] button.**
**Trimming an Image**

You can trim an image within your desired range.

1. **Select the [Tools] menu > [Start Trimming tool].**
   - The trimming window appears.

2. **Trim the image.**
   - Select a ratio from the [Aspect ratio] list box, and drag the trimming range as shown in the diagram.

   - If you move the cursor in the trimming range you have set, the [ ] changes to [ ].
   - You can move the trimming range by dragging.
   - If you move the cursor to the four corners of the trimming range you have set, the [ ] changes to [ ] or [ ]. You can change the trimming range size by dragging.
   - When [Free] is selected in the [Aspect ratio] list box, move the cursor to all four sides of the set trimming range and [ ] will change to [ ] or [ ]. The size of the trimming range can be changed by dragging.

3. **Click the [OK] button.**
   - You can also set the [Aspect ratio] and switch between full screen/normal screen from the menu that appears by right-click on the image.
   - For information on shortcut keys, refer to the “Shortcut List” (p.5-3).

[Diagram showing the trimming window with various options and settings.]
Correcting an Image

You can correct an image using the repair function or the copy stamp function.

Repairing
You can correct an image so that unwanted spots (spots you want to delete) on the image blend with surrounding color.

1. Select the [Tools] menu ➔ [Start Stamp tool].
   ➔ The copy stamp window appears.

2. Click the [100% View] button.
   ➔ The image is displayed in the 100% view.

3. Display the section you want to correct.
   ➔ Drag the image to display the section you want to correct.

4. Click the [Repair (Light)] button or the [Repair (Dark)] button.
   ➔ When the unwanted spot (spot you want to delete) is light in color, click the [Repair (Light)] button and when it is dark in color, click the [Repair (Dark)] button.
   ➔ Move the cursor over the image and the correction range is displayed as [O].

5. Cover the unwanted spot in the image with the correction range [O] and click.
   ➔ The unwanted spot within the correction range is corrected.
   ➔ If you then click on the image, the unwanted spots within the selected correction range are corrected.
   ➔ To correct another section of the image, cancel the repair function by right-clicking or clicking the [Repair (Light)] button or the [Repair (Dark)] button, and perform the operation from step 3 again.

6. Click the [OK] button.
   ➔ When sections of the image that cannot be corrected with the repair function have been selected, [O] is displayed.

   *Functions when you have selected multiple images and the copy stamp windows are displayed.

   [Repair (Light)] button
   Corrects an isolated light spot within the correction range to match the surrounding color.

   [Repair (Dark)] button
   Corrects an isolated dark spot within the correction range to match the surrounding color.

   [Select Copy Source] button
   Selects the copy source used for the repair function.

   [Radius] slider
   Adjusts the size of the correction range.

   [Fix Copy Source position] checkbox
   Locks the copy source position.

   [Undo] button
   Undoes the previous action.

   [Redo] button
   Redoes the previous action.

   [Undo] button
   Redoes the previous correction.

   [Redo] button
   Redoes all the corrections.

   [Copy] button
   Copies the content of the corrections specified.

   [Paste] button
   Applies the content of the corrections copied.

   [Prev] button
   Displays the previous image.*

   [Next] button
   Displays the next image.*

   [OK] button
   Applies the settings and closes the window.

   [Cancel] button
   Cancels all settings and closes the window.

   *Functions when you have selected multiple images and the copy stamp windows are displayed.
Copy Stamp
You can correct an image by pasting a section copied from another part of the same image to an unwanted part of the image.

1 Select the [Tools] menu ► [Start Stamp tool].
   → The copy stamp window appears.

2 Click the [100% View] button.
   → The image is displayed in the 100% view.

3 Display the section you want to correct.
   ○ Drag the image to display the section you want to correct.

4 Specify the section to copy.
   ○ Click the [Select Copy Source] button and then click the section to copy.
   ○ To change the copied section, repeat the above procedure.

5 Correct the image.
   ○ Click or drag on the section you want to correct on the image. [+1] in the window indicates the copy origin, and [-] indicates the copy destination.
   → The copied image is pasted in the position where you dragged.

6 Click the [OK] button.
   ○ In step 2, you can double-click on the section you want to correct to display the 100% view. You can also double-click again to return to the original view.
   ○ In step 4, you can also specify the section to copy by holding down the <Alt> key and clicking.
   ○ For information on shortcut keys, refer to the “Shortcut List” (p.5-3).
Using Edits (Recipe Data)

Editing data that has been applied to RAW images (p.1-6 to p.1-9, p.2-3 to p.2-6) or editing data that has been applied to JPEG, TIFF, and RAW images (p.1-9 to p.1-12, p.2-6 to p.2-8) can be copied and applied to other images. Editing data can also be saved as a separate file containing editing data only and loaded into other images. In Digital Photo Professional, editing data is referred to as “recipe data”.

**Saving the Recipes**

1. Select an image and then select [Edit] menu ▶ [Save recipe in file].
   - The [Save As] dialog box appears.

2. Select the destination folder, enter the file name, and then click the [Save] button.

   - When you select [Save recipe in file], only recipe data (editing data) is saved as a separate file. If you wish to save the image to which the edits were applied, see “Saving Edited Images” (p.1-14).
   - Image rotation (p.1-2), trimming (p.1-10) and image correction (repair, copy stamp) (p.1-11, p.1-12) are not included in recipe data.

**Loading and Pasting Recipes**

1. Select an image and then select [Edit] menu ▶ [Read recipe from file].
   - The [Open] dialog box appears.

2. Select a recipe and click the [Open] button.

3. Select an image to which the recipe will be applied and then select [Edit] menu ▶ [Paste recipe to selected photo].

   - Editing data that can be performed on RAW images only (p.1-6 to p.1-9, p.2-3 to p.2-6) cannot be applied to JPEG and TIFF images. If you try to apply editing data that can be applied to all image types (JPEG, TIFF, or RAW images) (p.1-9 to p.1-12, p.2-6 to p.2-8) together with editing data that can be applied only to RAW images (p.1-6 to p.1-9, p.2-3 to p.2-6), and the target image is in JPEG or TIFF, only the editing data applicable to JPEG and TIFF is applied.
Reverting Edited Images to Their Original Condition

You can cancel all the edits for images, and revert the edited images to their original settings before being edited or when shots were taken.

### Reverting to Last Saved Settings

Select an image and then select [Adjustment] menu ➔ [Revert to last saved settings].

If you select multiple images, all the edited images that you selected are reverted to the last saved settings.

### Reverting to Shot Settings

Select an image and then select [Adjustment] menu ➔ [Revert to shot settings].

If you select multiple images, all the edited images that you selected are reverted to the shot settings.

---

### Saving Edited Images

You can apply edits to one or more images and save the edited images.

#### Saving by Overwriting

You can apply edits to an image and overwrite the existing image.

Select an image and then select [File] menu ➔ [Add recipe and save].

#### Saving and Renaming

You can apply edits to images and save the new images with another name.

1. Select an image and then select [File] menu ➔ [Add recipe and save as].
   
   → The [Save As] dialog box appears.

2. Select the destination folder, enter the file name, and then click the [Save] button.

#### Adding a Thumbnail of the Image

You can create new thumbnails to use for display in the main window, and add to each image. The images will be displayed in the main window quicker and the quality of the images will increase.

Select the image and then select [File] menu ➔ [Add thumbnail to image and save].

A large number of images may take some time to add.
Converting and Saving RAW Images while Renaming Them

You can convert edited RAW images to the TIFF or JPEG and save them with another name.

1. Select an image and then select [File] menu ➤ [Convert and save].
   → The [Save As] dialog box appears.

2. Specify the settings and click the [Save] button.

Enter the name of the image to be saved.
Select an image type used when the image is saved.
The image types and extensions used for the saved images are shown below.

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exif-JPEG</td>
<td>.JPG</td>
</tr>
<tr>
<td>Exif-TIFF 8bit</td>
<td>.TIF</td>
</tr>
<tr>
<td>TIFF 16bit</td>
<td>.TIF</td>
</tr>
</tbody>
</table>

Check this checkbox to change the size of the image to be saved.
Check this checkbox to fix the vertical/horizontal ratio of the image.
Check this checkbox to embed an ICC profile in the image to be saved.
Check this checkbox to change the size of the image to be saved.
Set the width of the image.
Set the height of the image.
Specify a value between 1 and 60,000 dpi as the output resolution used for the image to be saved.
Select a unit of measurement.

If you have saved an image in which [Wide Gamut RGB], [Apple RGB] or [ColorMatch RGB] color space (p.1-9, p.1-21) has been specified, an ICC Profile is automatically embedded even if you have not checked [Embed ICC profile in image].

You can save and rename images without editing them.
[Resize setting] changes the image size by applying the larger numeric value set in “Width” or “Height” to the longer edge of the image, even when horizontal and vertical images are mixed together.
When you have set the tone curve to [Linear] (p.2-6), select [TIFF 16bit] and save.

The specified preferences (p.1-21) or individually specified color space (p.1-9) are added to the ICC profile embedded in TIFF or JPEG images. An ICC profile contains color information, such as color properties and color spaces of devices which are authorized by International Color Consortium (ICC). With this ICC profile, many color management systems can minimize the color differences between devices.
Converting and Saving Images in a Single Operation (Batch-processing)

You can save and rename multiple edited images in a single operation. You can also convert edited RAW images to JPEG or TIFF and save them in a single operation.

1. Edit an image (p.1-6 to p.1-12).

2. Select images to be converted and saved in a single operation.

3. Click the [Batch process] button (p.1-2).
   - The [Batch settings] dialog box appears.
   - Alternatively, you can display this dialog box by selecting [File] menu [Batch process].

4. Specify the settings.

5. Click the [Execute] button.
   - The processing window appears, allowing images to be saved in a single operation.
   - When processing is complete, the images are saved in the specified folder and the [Exit] button appears on the processing window.

6. Click the [Exit] button.

- You cannot save multiple images in a single operation unless you specify [Sequence number] when the [New file name] is selected for [File name].

- If you have saved an image in which [Wide Gamut RGB], [Apple RGB] or [ColorMatch RGB] color space (p.1-9, p.1-21) has been specified, an ICC Profile is automatically embedded even if you have not checked [Embed ICC profile].

- The specified preferences (p.1-21) or individually specified color space (p.1-9) are added to the ICC profile embedded in TIFF or JPEG images. An ICC profile contains color information, such as color properties and color spaces of devices which are authorized by International Color Consortium (ICC). With this ICC profile, many color management systems can minimize the color differences between devices.
Changing File Names in a Single Operation

You can change file names in a single operation.

1. **Select the images for which you want to change the file names.**

2. **Select the [Tools] menu ➤ [Start Rename tool].**
   - The rename tool window appears.

3. **Specify the settings and then click the [Execute] button.**
   - The operation begins and the file names are changed.

![Image of the Rename Tool Window]

- **Select** an item to be set in the file name from each item.
- **Select** the order of the files.
- **Selects** the extension.
- **Selects** the shot date and time format.
- **Enters** an underbar.
- **Makes** the file names of simultaneously recorded RAW and JPEG images the same (except for the extension).
- **Copies** the image and changes the file name.
- **You can store a set sequence number.**
- **When** [Copy_Rename] is checked, specifies the save destination of the copied images.
- **The original file names are displayed.**
- **The modified file names are displayed.**
- **Cancels** all settings and closes the window.
- **Modifies** the file names.
- **Specify** the settings and then click the [Execute] button.

---

1. Select the images for which you want to change the file names.
2. Select the [Tools] menu ➤ [Start Rename tool].
   - The rename tool window appears.
3. Specify the settings and then click the [Execute] button.
   - The operation begins and the file names are changed.

You can change file names in a single operation.

1. **Select** the images for which you want to change the file names.
2. **Select** the [Tools] menu ➤ [Start Rename tool].
   - The rename tool window appears.
3. **Specify** the settings and then click the [Execute] button.
   - The operation begins and the file names are changed.

You can change file names in a single operation.

1. Select the images for which you want to change the file names.
2. Select the [Tools] menu ➤ [Start Rename tool].
   - The rename tool window appears.
3. Specify the settings and then click the [Execute] button.
   - The operation begins and the file names are changed.

You can change file names in a single operation.
**Transferring Images to Image Editing Software**

**Transferring One Image to Photoshop**

You can transfer an image to Adobe Photoshop.

1. **Select the image to transfer to Photoshop.**
2. **Select [Tools] menu ➔ [Transfer to Photoshop].**
   - Photoshop starts up and displays the transferred image.
   - RAW images are converted to TIFF 16bit images before being transferred.

In order to transfer images, you will need Adobe Photoshop.
- Compatible versions of Photoshop are CS and 7.0. You cannot transfer images to Photoshop Elements.
- One image can be transferred at a time. You cannot transfer multiple images at a time.
- When images are transferred, they are automatically converted to the TIFF 16bit images and the ICC profile is attached to each of them. The specified preferences (p.1-21) or individually specified work color space (p.1-9) information are added to the ICC profile, which allows Photoshop to display images including that color information.

**Transferring Multiple Images to Image Editing Software**

You can transfer multiple images to image editing software. The description given here use Adobe Photoshop CS, as an example.

1. **Set convert/save in a single operation.**
   - Follow steps 1 to 4 of “Converting and Saving Images in a Single Operation (Batch-processing)” (p.1-16).
2. **Click [Browse] button in the [Batch settings] window.**
   - The [Open] window appears.

3. **Select the image editing software (Photoshop CS) to which you will transfer the images.**
   - Select [C:] drive ➔ [Program Files] ➔ [Adobe] ➔ [Photoshop CS] ➔ [Photoshop], and then click the [Open] button.

4. **Check the [Open image using software].**

5. **Click the [Execute] button.**
   - The processing window appears and saving in a single operation begins.
   - When saving in a single operation is completed, Photoshop starts up and the transferred images are displayed.

In order to transfer images, you will need image editing software such as Adobe Photoshop.
Printing Images
Images can be automatically adjusted and printed within the print range.

1 Select an image and then select [File] menu ➔ [Print].
2 Select a printer to be used and then click the [OK] button.
   ➔ Printing begins.

- You can set a printer profile to be used for printing. You can select a rendering intent (matching method) when you have set the profile (p.1-21).
- If you have set CMYK simulation profile (p.1-21), the image is printed in a tone corresponding to the specified [CMYK simulation profile].

Printing with Easy-PhotoPrint
Easy-PhotoPrint is printing software dedicated for Canon BJ printers.
If Easy-PhotoPrint 2.1 or later has been installed in your computer, you can print images with Easy-PhotoPrint.

Select an image and then select [File] menu ➔ [Print with Easy-PhotoPrint].
   ➔ Easy-PhotoPrint starts up.
   ➔ Follow the instructions displayed on the Easy-PhotoPrint window to print images.

- To print images with Easy-PhotoPrint, you need Easy-PhotoPrint 2.1 or later and a Canon BJ printer that supports Easy-PhotoPrint 2.1 or later.
- The specified output resolution (p.1-20) and trimming (p.1-10) are not supported.
- The setting of CMYK simulation (p.1-21) is not supported.

- You can set a rendering intent (matching method) when printing (p.1-21).

Displaying Images in EOS Capture
Digital Photo Professional version 2.0 is compatible with EOS Capture version 1.1 or later.
If you have EOS Capture version 1.1 or later installed on your computer, Digital Photo Professional displays the images shot with EOS Capture.

1 Connect the camera to your computer and set the camera’s power switch to <ON>.
   ➔ When [CameraWindow] and other windows are displayed, close all the displayed windows.
2 Select [Tools] menu ➔ [Start EOS Capture].
   ➔ EOS Capture starts up.
3 Take a shot.
   ➔ Click the [Shoot] button in EOS Capture or press the shutter button on the camera to take a shot.
   ➔ The shot image is displayed in the Digital Photo Professional main window.

- When EOS Capture starts up, you can switch the Digital Photo Professional window automatically from the main window to the edit image window (p.1-20).
Specifying Preferences

You can specify various settings for Digital Photo Professional.

   → The [Preferences] dialog box appears.
2. Select the desired tab, specify the settings, and then click the [OK] button.
   → The settings are applied and the [Preferences] dialog box closes.

- Allows you to select whether the edited image is saved automatically or the confirmation dialog box is displayed, when you exit Digital Photo Professional or change images displayed in the main window to the ones in another folder.
- Allows you to select whether the folder that was open the last time is displayed or the specified folder is always displayed when Digital Photo Professional starts up.
- Allows you to set the output resolution default value from 1 to 60,000 dpi when RAW images are converted to JPEG or TIFF images and saved.

![Preferences Dialog Box]

- Specify the image quality for displaying or saving images.
  - **[Quality priority]**: Images are displayed and saved with maximum quality because additional filter processings are applied. However, it takes more time to display or save images.
  - **[Standard]**: Images are displayed at maximum speed with no additional filter processing. Images are saved at the same quality as [Quality priority].
  - **[Speed priority]**: Images are displayed and saved at maximum speed because no additional filter processing is applied.

- If you check this checkbox, an image opened in the edit window will appear selected in the main window.

- Select the display mode for displaying the edited and original images for comparison in the edit or edit image window (p.2-3):
Allows you to select the histogram displayed in the [RGB image adjustment] tab sheet on the tool palette.

Select [Tone curve mode] (tone curve display), [Interpolation method] (tie method) displayed in the [RGB image adjustment] tab sheet on the tool palette (p.2-7).

Check to preserve [Hue], [Saturation] and [Sharpness] set for each Picture Style item (p.2-5, p.2-6).

To select a monitor or printer profile, you need to have previously installed the monitor and printer profiles to be used on the computer. For details on the monitor and printer profiles to be used, refer to the user manual of each device.

When you restart Digital Photo Professional after changing [Default settings of RGB tone curve] in the [Tool palette] tab sheet or [Default settings of Work color space] in the [Color management] tab sheet, the setting content is applied. However, the setting content is not applied to an image which has been edited before a change was made (p.1-9 to p.1-12, p.2-6 to p.2-8) and which has a [RGB] mark displayed (p.1-3). Change an individual tone curve with the menu (p.2-7) that appears by right-clicking on the tone curve, and an individual color space by selecting the [Adjustment] menu ► [Work color space] (p.1-9).

The specified color space is added to the ICC profile that is embedded in TIFF or JPEG images that have been converted from RAW images and saved (p.1-15, p.1-16). A color space is the reproducible color range (the characteristics of color gamut). Digital Photo Professional supports the following 5 kinds of color space.

- **sRGB**: Standard color space for Windows. Widely used for the standard color space of monitors, digital cameras, and scanners.
- **Adobe RGB**: A wider color space than sRGB. Mainly used for printing for business purposes.
- **Wide Gamut RGB**: A wider color space than Adobe RGB.
- **Apple RGB**: Standard color space for Macintosh. A slightly wider color space than sRGB.
- **ColorMatch RGB**: A slightly wider color space than sRGB. Mainly used for printing for business purposes.

You can select a rendering intent (matching method) from [Perceptual] or [Colorimetric] for color conversion when printing an image.

- **Perceptual**: Matching method generally suited to natural images such as photographs which minutely expresses intermediate colors such as skin tones and the blue of the sky.
- **Colorimetric**: Matching method generally suited to graphic-type images such as photographs which expresses an image in the vivid primary colors of red, blue and yellow.

With [CMYK simulation profile], you can simulate the color used when you print in a CMYK environment such as that of a printer. Digital Photo Professional is compatible with the following 4 types of printing profiles.

- **Euro Standard v1.00**: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- **JMPA v1.10**: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- **U.S. Web Coated v1.00**: Profile normally used for book printing in North America, suitable for simulation of North American standard color printing.
- **JapanColor2001 type3**: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

Allows you to select the histogram displayed in the [RGB image adjustment] tab sheet on the tool palette.
Select a work color space from 5 kinds of color space.

Select a rendering intent (matching method) when a CMYK simulation profile has been set.

Select a rendering intent (matching method) for printing with Easy-PhotoPrint (p.1-19).

Select a CMYK simulation profile to be used in CMYK simulation. The image is displayed in the colors of the selected profile and you can simulate the color used when you print in a CMYK environment such as that of a printer. With this setting, [CMYK] is displayed at the bottom of each window (p.1-2, p.2-2, p.3-1).

The CMYK simulation display can be temporarily canceled in the edit window (p.2-2) and the edit image window (p.3-1) by holding down the <Ctrl> + <Y> keys on the keyboard.

Select a printer profile to be used for printing images (p.1-19).
This chapter describes the functions of the edit window, and how to display images and perform detailed edits on them.

This chapter describes the functions that you can operate in the edit window only. For instructions on operating the functions common to those in the main window, refer to the page described with each item.
Displaying the Edit Window

You can enlarge a single image and perform detailed edits on it in the edit window. You can display multiple edit windows and edit them while comparing each of them (up to 36 images can be displayed).

- This chapter describes the functions that you can operate in the edit window only. For instructions on operating the functions common to those in the main window, refer to the page described with each item.

**Double-click a thumbnail image in the main window.**
- The edit window appears.
- A low resolution image is displayed first in the edit window, and then it switches to a high resolution image.
- Alternatively, you can display this window by selecting [File] menu > [Open in Edit window].

**Edit Window**

- **Menu bar**
  - Displays the [File], [Edit], [View], [Adjustment], [Tools], [Window], and [Help] menus.
  - The path for the image and file name are displayed.

- **Image display area**
  - Displays the color space ([RAW] is displayed for RAW images) of the image and the work color space (p.1-9, p.1-21).

- **Tool Palette**
  - RAW image adjustment tab sheet (p.2-3)
  - RGB image adjustment tab sheet (p.2-6)
  - Displays the coordinates of the cursor position and the RGB values (8-bit conversion) of an image.
  - Displays the operation mode (p.1-20).
  - Displays the coordinates of the cursor position and the RGB values (8-bit conversion) of an image.

- **Edit Window**
  - When you set CMYK simulation profile (p.1-21), [CMYK] is displayed. The CMYK simulation display can be canceled temporarily by holding down the <Ctrl> + <Y> keys on the keyboard.

- **For some images, it may take some time to switch to the high resolution image.**

- **To display or hide the tool palette, select the [View] menu > [Tool palette].**
- **If you have multiple edit windows displayed, you can display a sequence of the edit windows by selecting [Window] menu > [Arrange horizontally] or [Arrange vertically].**
- **To exit the edit window, select [File] menu > [Close].**
- **You can select whether the tool palette is displayed as another window or displayed within the same window (p.1-21).**
- **For information on shortcut keys, refer to the "Shortcut List" (p.5-2).**
Selecting the Image Display Mode

You can change the size and method in which images are displayed.

**Selecting the Display Size**

You can select the image size from [Fit to window] (Fitting to the image display area), [50% view], [100% view] (actual pixel size), and [200% view].

1. **Select [View] menu ▶ Select the size to be set.**
   - The image is displayed in the selected size.
   - When you display an image in a larger size, you can change the display position by dragging the image.

   ![Image Display Modes](image1.png)

2. **In the [Fit to window] display, if you double-click a section you want to enlarge, the display changes to the [100% view] display. If you double-click on the image in the [50% view], [100% view] or [200% view] display, the display changes to the [Fit to window] display.**

3. **Selecting the Display Size**

   ![Selecting Image Size](image2.png)

4. **Displaying the Grid Lines**

   You can display grid lines that allow you to check the horizontal or vertical level of the image.

   1. **Select [View] menu ▶ [Grid lines].**
   - Grid lines are displayed on the image.
   - Performing the same operation again hides the grid lines.

   ![Grid Lines Displayed](image3.png)

5. **Displaying the Edited Image and the Original at the Same Time**

   You can display the edited image and the original at the same time.

   1. **Select [View] menu ▶ [Before/after comparison].**
   - A split window with the image before and after editing is displayed.

   ![Before After Comparison](image4.png)

6. **Changing the Display Position**

   You can also tile images vertically.

   1. **Select [View] menu ▶ [Change up/down/left/right].**
   - Performing the same operation again tiles images horizontally.

   ![Changing Display Position](image5.png)

Editing RAW Images

You can perform more detailed edits on RAW images that are supported by Digital Photo Professional, than in the main window. With RAW image editing (p.2-3 to p.2-6), there is hardly any of the deterioration which accompanies image editing. You can therefore edit an image multiple times while preserving the image quality at the time the image was shot.

1. **Display the RAW image in the edit window (p.2-2).**
   - When multiple images are displayed, click the image for which you wish to edit to place it in the top window.

2. **Select the [RAW image adjustment] tab on the tool palette.**
   - The [RAW image adjustment] tab sheet appears.

   ![RAW Image Adjustment](image6.png)

3. **Edit the RAW images (p.2-3 to p.2-6).**
   - You can apply edits to other images by copying and pasting the edit data to the other images (p.1-13).
   - You can revert edited images to the last saved settings or shot settings (p.1-14).

4. **Compare the edited image with the original (see left).**

5. **Save the edited image (p.1-14).**
   - You cannot edit PowerShot Pro1 RAW images.
   - Before exiting Digital Photo Professional, you must save the edited images (p.1-14).

   ![Save Edited Image](image7.png)

Adjusting the Brightness

You can adjust the brightness in the range of –2.0 to +2.0 (in 0.01-stop increments when entering a value).

1. **Adjust an image while viewing it.**

   ![Brightness Adjustment](image8.png)

   - Drag the slider left or right to adjust the brightness.
   - Enter a value to adjust the brightness.

   ![Brightness Adjusted](image9.png)
Adjusting the White Balance
You can set the white balance with each method.

Selecting the White Balance (p.1-7)
You can set the white balance.

Specifying the Color Temperature (p.1-7)
You can specify the color temperature in the range of 2800 to 10000K (in 100K increments).

Click White Balance Function
Makes white the standard for the point you selected and color in the image is adjusted.

1 Click the [Click] button.
   ➔ When you move the cursor over the image, the cursor [ ] changes to [ ].

2 Click the point where is to be the standard.
   ➔ The color in the image is adjusted with white as the standard on the point you selected.
   • If you click on another point over the image, the white balance is adjusted again.
   • When you finish this operation, click the [Click] button or right-click.

   • The image is adjusted based on the average value of the range of 5 × 5 pixels from the clicked point.
   • Even if you have selected a neutral gray point of the image, the result of adjustments is the same as when you select a white point.

Adjusting with the Color Wheel (p.1-8)
You can select a desired color from the color wheel. You can also specify the hue in the range of 0 to 359 (in 1-stop increments), and the saturation in the range of 0 to 255 (in 1-stop increments).

Registering Adjusted White Balance
(Personal White Balance)
You can register up to 3 adjusted white balance data as personal white balance settings.

1 Adjust the white balance.

2 Click the [Register] button.
   ➔ The [Register personal white balance] dialog box appears.

3 Select the number of the button to be registered from the list.

4 Click the [OK] button.

Personal White Balance (p.1-8)
You can apply the registered personal white balance to images.
Setting Picture Style

Selecting a Picture Style
You can set the Picture Style.

Select a Picture Style from the list box.

<table>
<thead>
<tr>
<th>Picture Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>The image looks vivid, sharp, and crisp.</td>
</tr>
<tr>
<td>Portrait</td>
<td>For nice skin tones. The image looks slightly sharp and crisp. By changing the [Hue] (p.2-6), you can adjust the skin tone.</td>
</tr>
<tr>
<td>Landscape</td>
<td>For vivid blues and greens, and very sharp and crisp images.</td>
</tr>
<tr>
<td>Neutral</td>
<td>For natural colors and subdued images. No sharpness is applied.</td>
</tr>
<tr>
<td>Faithful</td>
<td>When the subject is photographed under a color temperature of 5200K, the color is adjusted colorimetrically to match the subject’s color. No sharpness is applied.</td>
</tr>
<tr>
<td>B/W</td>
<td>For black-and-white images.</td>
</tr>
</tbody>
</table>

(Picture Style file set in the camera) Displayed when selecting an image shot with Picture Style file set in the camera. In the list, the caption name of the Picture Style file set in the camera is displayed with ( ) attached.

[loaded Picture Style file] The Picture Style loaded by clicking the [Browse] button is applied. In the list, the caption name of the Picture Style file loaded by clicking the [Browse] button is displayed with [ ] attached.

Applying a Picture Style file
You can load and apply to images Picture Style files downloaded from Canon’s web site and saved on your computer.

1. Click the [Browse] button. → The [Open] window is displayed

2. Select a Picture Style file and click the [Open] button. → The Picture Style file is loaded.

3. Select loaded Picture Style file from the list box. → The loaded Picture Style file is applied to the image.

A Picture Style file is a file that expands the Picture Style function. For detailed information on Picture Style files, refer to Canon’s web site.

Adjusting the Shadow and Highlight Points
You can specify the shadow point (the darkest point) and highlight point (the brightest point) to adjust the gradation of images.

Adjust an image while viewing it.

When you move the cursor to the right edge of the graph, the cursor [ ] changes to [ + ]. Drag the slider right to adjust the shadow point.

When you move the cursor to the right edge of the graph, the cursor [ ] changes to [ + ]. Drag the slider left to adjust the highlight point.
Selecting the Tone Curve
You can select the tone curve.

Select a tone curve while viewing the image.

Selecting the Tone Curve

Adjusting the Hue, Saturation and Sharpness
The hue and saturation can be adjusted in the range of –4 to +4 (in 1-step increments), and sharpness in the range of 0 to 10 (in 1-step increments).
Also, when [BW] is selected from the [Picture Style] list box (p.2-5), you can select from 5 types of [Filter effect] displayed ([None], [Yellow], [Orange], [Red], [Green]), and 5 types of [Toning effect] ([None], [Sepia], [Blue], [Purple], [Green]).

Adjust an image while viewing it.

Selecting the Tone Curve

Editing Images
You can perform various edits on the RAW, JPEG, and TIFF images that are supported by Digital Photo Professional.

1 Display the image in the edit window (p.2-2).
   - When multiple images are displayed, click the image for which you wish to edit to place it on the top window.

2 Select the [RGB image adjustment] tab on the tool palette.
   - The [RGB image adjustment] tab sheet appears.

3 Edit the image (p.2-7, p.2-8).
   - You can apply edits to other images by copying and pasting the edit data to the other images (p.1-13).
   - You can revert edited images to the last saved settings or shot settings (p.1-14).

4 Compare the edited image with the original (p.2-3).

5 Save the edited image (p.1-14).
   - Before exiting Digital Photo Professional, you must save the edited images (p.1-14).
   - The editing data can be saved in a separate file (p.1-13).
**Adjusting the Tone Curve**

A tone curve shows the brightness and color saturation for the original image (input) and the adjusted image (output) in the form of a line graph. You can use the tone curve to adjust the image brightness and color saturation values that were set by the camera automatically when the shot was taken. Also, you can adjust the input and output of [R] (Red), [G] (Green) and [B] (Blue). The horizontal axis shows the brightness and color saturation for the original image (input) image, with the left-hand end indicating shadow (darker areas of the image) and the right-hand end indicating highlights (brighter areas of the image). The vertical axis shows the brightness and color saturation for the adjusted image (output), with the lower end indicating shadow and the upper end indicating highlights.

**Adjusting the Tone Curve**

1. **Click the button to select a channel.**

   - The same settings are applied to all RGB channels.
   - The settings are applied to the B channel.
   - The settings are applied to the G channel.
   - The settings are applied to the R channel.

2. **Adjust the tone curve.**

   - Clicking the tone curve shows [ ] on the tone curve. Drag [ ] to your desired location.
   - You can specify up to 8 points of [ ].
   - Double-clicking [ ] or pressing the <Delete> key on the keyboard deletes it.

   - When you move the cursor to the top of the graph, [ ] changes to [ ]
     - Drag it downward to adjust the highlight point in the output side.
   - When you move the cursor to the bottom of the graph, [ ] changes to [ ]
     - Drag it upward to adjust the shadow point in the output side.
   - Enter a value to specify the maximum output.
   - Enter a value to specify the minimum output.
   - Enter a value in the range of 0 to 247 (in 1-stop increments) to adjust the shadow point.
   - Enter a value in the range of 8 to 255 (in 1-stop increments) to adjust the highlight point.

   - Horizontal axis: Input level
   - Vertical axis: Output level

   - Horizontal axis: Input level
   - Vertical axis: Output level

   - The minimum number of steps between the shadow point and the highlight point is 8.

   - You can change the tone curve interpolation method (Curve/Straight) or tone curve modes (RGB R G B/Luminance R G B) from the menu that appears by right-click on a tone curve, or from the [Tool palette] tab sheet in the [Preferences] dialog box (p.1-21).
Click White Balance Function
Makes white the standard for the point you selected and color in the image is adjusted.

1. Click the [Click] button.
   - When you move the cursor over the image, the cursor [ ] changes to [ ].

2. Click the point where is to be the standard.
   - The color in the image is adjusted with white as the standard on the point you selected.
   - If you click on another point over the image, the white balance is adjusted again.
   - When you finish this operation, click the [Click] button or right-click.

   - The image is adjusted based on the value of 1 X 1 pixels from the clicked point.
   - Even if you have selected a neutral gray point of the image, the result of adjustments is the same as when you select a white point.

Adjusting the Brightness and Contrast
You can adjust the brightness and contrast in the range of –100 to +100 (in 1-stop increments when entering a value).

Adjust an image while viewing it.

Adjusting the Hue, Saturation and Sharpness
You can adjust the hue in the range of –30 to +30 (in 1-step increments when entering a value), the saturation in the range of 0 to 200 (in 1-step increments when entering a value) and the sharpness in the range of 0 to 500 (in 1-step increments when entering a value).

Adjust an image while viewing it.
Performing Detailed Edits in the Edit Image Window

In the edit image window, you can select one image from multiple images and perform detailed edits on the selected image.

- The functions of the edit image window are the same as those of the main window (chapter 1) and of the edit window (chapter 2).
- For detailed instructions on operating these functions, refer to the page described with each item.

1. **Select multiple images in the main window.**
2. **Click the [Edit image window] button.**
   - The main window switches to the edit image window.
   - The image clicked in the thumbnail image display area is displayed in the image display area.
   - A low resolution image is displayed first, and then it switches to a high resolution image.
   - Alternatively, you can display this window by selecting [View] menu » [Edit in Edit image window].

**Edit Image Window**

- **Menu bar**
  - Displays the [File], [Edit], [View], [Adjustment], [Tools], and [Help] menus.
  - The path for the image and file name are displayed.
- **Toolbar**
  - Displays grid lines on the selected image.
  - Fits the image in the window.
  - Scales down the image 50%.
  - Thumbnail image display area
  - Image display area
    - When you display an image in a larger size, you can change the display position by dragging the image.
- **Image display area**
  - Displays the color space ([RAW] is displayed for RAW images) of the image and the work color space (p.1-9, p.1-21).
  - Displays the coordinates of the cursor position and the RGB values (8-bit conversion) of an image.
  - Displays the operation mode (p.1-20).
- **Tool Palette**
  - RAW image adjustment tab sheet (p.2-3)
  - RGB image adjustment tab sheet (p.2-6)
  - Displays the operation mode (p.1-20).
  - If you set the tool palette to [Docking display] (p.1-21) and make the edit image window large, a thumbnail of the image will be displayed. (When the tool palette is set to [Floating display] (p.1-21), the thumbnail image is always displayed.) The enlarged display position is displayed on the thumbnail and you can move the display position by dragging.

- **Select the [View] menu » [Change thumbnail position] to change the position of the thumbnail image display area.**
- **To delete an image from the thumbnail image display area, select the [File] menu » [Delete from list].**
- **To exit the edit image window, click the [Main window] button.**

- For some images, it may take some time to switch to the high resolution image.

- **You can select whether the tool palette is displayed as another window or displayed within the same window (p.1-21).**
- **For information on shortcut keys, refer to the "Shortcut List" (p.5-2).**
4 Displaying an Image in the Quick Check Window

In the quick check window, enlarged images are displayed and they can be quickly viewed and checked.

1 Select multiple images in the main window.

2 Select the [Tools] menu -> [Start Quick check tool].
   The quick check window appears.

3 View and check the images.

4 Click the [OK] button.

Quick Check Window

- Displays the full screen.
- Displays the previous image.
- Displays the next image.
- Scales down the image 50%.
- Selects and sets a number from 3 types of check marks.
- Removes all the check marks.
- Rotates the image 90° to the left or right.
- Applies specified settings to the image and closes the quick check window.

The path for the image and file name are displayed.

- You can also specify each setting or switch between full screen/normal screen from the menu that appears when you right-click on the window.
- For information on shortcut keys, refer to the “Shortcut List” (p.5-3).
This chapter provides troubleshooting, the instructions on uninstalling Digital Photo Professional, and shortcut key list to allow you to use Digital Photo Professional easily.

**Troubleshooting**

If you could not complete the installation correctly, Digital Photo Professional does not work, or you could not display images with Digital Photo Professional, consult the items described below.

**Could not complete installation correctly.**

- Are you using Windows XP under a setting other than [Computer administrator] or using Windows 2000 under a setting other than [Administrator]?
  - You cannot install software if a user setting other than [Computer administrator] or [Administrator] is selected. Select the [Computer administrator] user setting in Windows XP or the [Administrator] user setting in Windows 2000. For detailed information on selecting the user setting, refer to the manuals supplied with your computer.

- Is there sufficient hard disk space?
  - 256 MB or more of hard disk space is required.

**Digital Photo Professional does not work.**

- Does your computer meet the system requirements for Digital Photo Professional?
  - Check the system requirements (p.0-2).

- Is there enough RAM (memory)?
  - Check the system requirements (p.0-2).

- Is the screen resolution less than [1024 by 768 pixels]? (p.0-2)
  - Specify [1024 by 768 pixels] or more for the screen resolution (p.0-2).

- Is the color quality less than [Medium (16 bit)]? (p.0-2)
  - Specify [Medium (16 bit)] or more for the color quality (p.0-2).

- Are multiple applications running?
  - Exit any applications other than Digital Photo Professional. Even if your computer has the RAM capacity (memory) described in system requirements (p.0-2), if other application is running at the same time as Digital Photo Professional, you may not have sufficient RAM (memory).

**Could not display images with Digital Photo Professional.**

- Did you try to display images other than the image types that are supported by Digital Photo Professional?
  - Check the supported images (p.0-2).

**Uninstalling the Software**

Follow the procedure below to uninstall Digital Photo Professional.

- Exit any applications before uninstalling Digital Photo Professional.
- To prevent computer malfunctions, always restart your computer after you have uninstalled Digital Photo Professional. Re-installing the software without first restarting your computer is particularly likely to result in computer malfunctions.

1. Select the [Start] button ➤ [Control Panel] ➤ [Add or Remove Programs].
   - For Windows 2000, select the [Start] button ➤ [Settings] ➤ [Control Panel] ➤ double-click the [Add/Remove Programs] icon.
   - The [Add or Remove Programs] dialog box (the [Add/Remove Programs] dialog box in Windows 2000) appears.

2. Select [Canon Utilities Digital Photo Professional x.x] from the software list, and then click the [Change/Remove] button.
   - “x.x” represents the version of Digital Photo Professional.
   - Confirm that [Change or Remove Programs] is selected.
   - The [Add or Remove Programs] dialog box (the [Add/Remove Programs] dialog box in Windows 2000) appears.

3. Click the [OK] button.
   - Digital Photo Professional is uninstalled.
# Shortcut Key List

## Main Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open in Edit window</td>
<td>Ctrl + O</td>
<td>Select check mark3 photos only</td>
<td>Ctrl + Alt + 3</td>
</tr>
<tr>
<td>Add recipe and save</td>
<td>Ctrl + S</td>
<td>Edit in Edit image window</td>
<td>Ctrl + Right Arrow</td>
</tr>
<tr>
<td>Add recipe and save as</td>
<td>Ctrl + Shift + S</td>
<td>Large thumbnail</td>
<td>Ctrl + 1</td>
</tr>
<tr>
<td>Add Thumbnail to images and save</td>
<td>Ctrl + Shift + T</td>
<td>Middle thumbnail</td>
<td>Ctrl + 2</td>
</tr>
<tr>
<td>Convert and save</td>
<td>Ctrl + D</td>
<td>Small thumbnail</td>
<td>Ctrl + 3</td>
</tr>
<tr>
<td>Batch process</td>
<td>Ctrl + B</td>
<td>Thumbnail with information</td>
<td>Ctrl + 4, Ctrl + 0</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl + P</td>
<td>Rotate Left</td>
<td>Ctrl + L</td>
</tr>
<tr>
<td>Print with Easy-PhotoPrint</td>
<td>Ctrl + E</td>
<td>Rotate Right</td>
<td>Ctrl + R</td>
</tr>
<tr>
<td>Delete</td>
<td>DEL</td>
<td>Add check mark1</td>
<td>Alt + 1</td>
</tr>
<tr>
<td>Info display</td>
<td>Ctrl + I</td>
<td>Add check mark2</td>
<td>Alt + 2</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt + F4</td>
<td>Add check mark3</td>
<td>Alt + 3</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl + X</td>
<td>Remove check mark</td>
<td>Alt + Z</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl + C</td>
<td>Start EOS Capture</td>
<td>Alt + O</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl + V</td>
<td>Transfer to Photoshop</td>
<td>Alt + P</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl + A</td>
<td>Start Quick check tool</td>
<td>Alt + Q</td>
</tr>
<tr>
<td>Clear All</td>
<td>Ctrl + Shift + A</td>
<td>Start Trimming tool</td>
<td>Ctrl + N, Alt + C</td>
</tr>
<tr>
<td>Select RAW photos only</td>
<td>Ctrl + Alt + A</td>
<td>Start Stamp tool</td>
<td>Alt + S</td>
</tr>
<tr>
<td>Select check mark1 photos only</td>
<td>Ctrl + Alt + 1</td>
<td>Start Rename tool</td>
<td>Alt + R</td>
</tr>
<tr>
<td>Select check mark2 photos only</td>
<td>Ctrl + Alt + 2</td>
<td>Preferences</td>
<td>Ctrl + K</td>
</tr>
</tbody>
</table>

## Edit Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add recipe and save</td>
<td>Ctrl + S</td>
<td>Rotate Left</td>
<td>Ctrl + L</td>
</tr>
<tr>
<td>Add recipe and save as</td>
<td>Ctrl + Shift + S</td>
<td>Rotate Right</td>
<td>Ctrl + R</td>
</tr>
<tr>
<td>Convert and save</td>
<td>Ctrl + D</td>
<td>Add check mark1</td>
<td>Alt + 1</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl + P</td>
<td>Add check mark2</td>
<td>Alt + 2</td>
</tr>
<tr>
<td>Info display</td>
<td>Ctrl + I</td>
<td>Add check mark3</td>
<td>Alt + 3</td>
</tr>
<tr>
<td>Close</td>
<td>Ctrl + W, Alt + F4</td>
<td>Remove check mark</td>
<td>Alt + Z</td>
</tr>
<tr>
<td>Show/hide Tool palette</td>
<td>Ctrl + T</td>
<td>Transfer to Photoshop</td>
<td>Alt + P</td>
</tr>
<tr>
<td>Fit to window</td>
<td>Ctrl + 4, Ctrl + 0</td>
<td>Start Trimming tool</td>
<td>Ctrl + N, Alt + C</td>
</tr>
<tr>
<td>50% view</td>
<td>Ctrl + 1</td>
<td>Start Stamp tool</td>
<td>Alt + S</td>
</tr>
<tr>
<td>Preferences</td>
<td>Ctrl + K</td>
<td>Cancel CMYK simulation</td>
<td>Ctrl + Y</td>
</tr>
</tbody>
</table>

## Edit Image Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add recipe and save</td>
<td>Ctrl + S</td>
<td>200% view</td>
<td>Ctrl + 3</td>
</tr>
<tr>
<td>Add recipe and save as</td>
<td>Ctrl + Shift + S</td>
<td>Rotate Left</td>
<td>Ctrl + L</td>
</tr>
<tr>
<td>Convert and save</td>
<td>Ctrl + D</td>
<td>Rotate Right</td>
<td>Ctrl + R</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl + P</td>
<td>Add check mark1</td>
<td>Alt + 1</td>
</tr>
<tr>
<td>Print with Easy-PhotoPrint</td>
<td>Ctrl + E</td>
<td>Add check mark3</td>
<td>Alt + 3</td>
</tr>
<tr>
<td>Delete from list</td>
<td>Ctrl + DEL</td>
<td>Remove check mark</td>
<td>Alt + Z</td>
</tr>
<tr>
<td>Info display</td>
<td>Ctrl + I</td>
<td>Start EOS Capture</td>
<td>Alt + O</td>
</tr>
<tr>
<td>Exit</td>
<td>Ctrl + W, Alt + F4</td>
<td>Transfer to Photoshop</td>
<td>Alt + P</td>
</tr>
<tr>
<td>Return to main window</td>
<td>Ctrl + Left Arrow</td>
<td>Start Trimming tool</td>
<td>Ctrl + N, Alt + C</td>
</tr>
<tr>
<td>Show/hide Tool palette</td>
<td>Ctrl + T</td>
<td>Start Stamp tool</td>
<td>Alt + S</td>
</tr>
<tr>
<td>Fit to window</td>
<td>Ctrl + 4, Ctrl + 0</td>
<td>Preferences</td>
<td>Ctrl + K</td>
</tr>
<tr>
<td>50% view</td>
<td>Ctrl + 1</td>
<td>Cancel CMYK simulation</td>
<td>Ctrl + Y</td>
</tr>
<tr>
<td>100% view</td>
<td>Ctrl + 2</td>
<td>Only functions while holding down the keys</td>
<td>Ctrl + Y</td>
</tr>
</tbody>
</table>

---

**Introduction**

- Displaying Thumbnail Images and Performing Basic Edits in the Main Window
- Performing Detailed Edits in the Edit Window
- Displaying an Image in the Quick Check Window
- Performing Detailed Edits in the Edit Image Window

**Cover/Table of Contents**

- Reference
- Index
### Quick Check Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>50% view</td>
<td>Ctrl + 1</td>
<td>Remove all check marks</td>
<td>Alt + Z, Z*</td>
</tr>
<tr>
<td>Fit to Window</td>
<td>Ctrl + 4</td>
<td>Switch check marks</td>
<td>V</td>
</tr>
<tr>
<td>Switch between full screen/nornal screen</td>
<td>Ctrl + T,</td>
<td>Rotate Left</td>
<td>Ctrl + L</td>
</tr>
<tr>
<td></td>
<td>Alt + Enter, F11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switch back to normal screen</td>
<td>Esc</td>
<td>Rotate Right</td>
<td>Ctrl + R</td>
</tr>
<tr>
<td>Add check mark1</td>
<td>Alt + 1, 1*</td>
<td>Display the previous image</td>
<td>Ctrl + Left Arrow, Page Up, Left Arrow</td>
</tr>
<tr>
<td>Add check mark2</td>
<td>Alt + 2, 2*</td>
<td>Display the next image</td>
<td>Ctrl + Right Arrow, Page Down, Right Arrow</td>
</tr>
<tr>
<td>Add check mark3</td>
<td>Alt + 3, 3*</td>
<td>Close the quick check window</td>
<td>Alt + S</td>
</tr>
</tbody>
</table>

* Only functions when in full screen.

### Trimming Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch between full screen/nornal screen</td>
<td>Alt + Enter, F11</td>
<td>Save the settings and close the trimming window</td>
<td>Alt + S</td>
</tr>
<tr>
<td>Switch back to normal screen</td>
<td>Esc</td>
<td>Reset the trimming range</td>
<td>Shift + Delete</td>
</tr>
<tr>
<td>Close the trimming window without saving the settings</td>
<td>Ctrl + W, Alt + F4</td>
<td>Move the trimming range</td>
<td>Up, Down, Left and Right Arrows</td>
</tr>
<tr>
<td>Display the previous image</td>
<td>Ctrl + Left Arrow</td>
<td>Enlarge/reduce the trimming range</td>
<td>Shift + Up, Down, Left and Right Arrows</td>
</tr>
<tr>
<td>Display the next image</td>
<td>Ctrl + Right Arrow</td>
<td>Set the level of opacity</td>
<td>Wheel up/down</td>
</tr>
<tr>
<td></td>
<td>Ctrl + C</td>
<td>Image display (Up: Brighter, Down: Darker)</td>
<td>Ctrl + Wheel up/down</td>
</tr>
<tr>
<td>Copy the trimming range</td>
<td>Ctrl + C</td>
<td>Display the previous image</td>
<td>Page Up</td>
</tr>
<tr>
<td>Paste the trimming range</td>
<td>Ctrl + V</td>
<td>Display the next image</td>
<td>Page Down</td>
</tr>
<tr>
<td>Undo the trimming settings</td>
<td>Ctrl + Z</td>
<td>Display the previous image</td>
<td>Page Down</td>
</tr>
</tbody>
</table>

### Copy Stamp Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch between full screen/normal screen</td>
<td>Alt + Enter, F11</td>
<td>Switch check marks</td>
<td>V</td>
</tr>
<tr>
<td>Switch back to normal screen</td>
<td>Esc</td>
<td>Close the stamp tool window without applying the content of the corrections</td>
<td>Ctrl + W, Alt + F4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Redo all the corrections</td>
<td>Ctrl + Shift + Y</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Redo all the corrections</td>
<td>Ctrl + Shift + Y</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select copy source* (only functions when in 100% view)</td>
<td>Alt + click</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Change the display position after copy source is selected (only functions when in 100% view)</td>
<td>Space + drag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set the radius of copy destination or correction range in 5 pixel units</td>
<td>Wheel up/down</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set the radius of copy destination or correction range in 1 pixel units</td>
<td>Shift + Wheel up/down</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Apply the content of the corrections and close the stamp tool window</td>
<td>Alt + S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set the pen type to brush*</td>
<td>B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set the pen type to pencil*</td>
<td>P</td>
</tr>
</tbody>
</table>

* Only functions when using copy stamp functions (p.1-12).
Index

A
Adjusting the Brightness .......................... 1-9
Adjusting the Brightness (RAW) ............. 1-9, 2-3
Adjusting the Tone Curve .......................... 2-7
Adjusting the Brightness and Contrast .......... 2-8
Adjusting the Hue, Saturation and Sharpness .... 2-8
Adjusting the Tone Curve .......... 2-7
Click White Balance Function .............. 2-8
Adjusting the White Balance ............. 1-6, 2-4
Adjusting with the Color Wheel .......... 1-8, 2-4
Click White Balance Function .......... 1-8, 2-4
Personal White Balance ........ 1-8, 2-4
Registering Adjusted White Balance (Personal White Balance) .......... 2-4
Selecting the White Balance ........ 1-7, 2-4
Specifying the Color Temperature .......... 1-7, 2-4

B
Example of Operation .......................... 0-4
Exiting Digital Photo Professional ............... 1-2
Exiting the Edit Image Window .............. 3-1
Exiting the Edit Window .......................... 2-2

C
Changing File Names in a Single Operation ........ 1-17
Copy Stamp Window .......................... 1-11, 1-12
Correcting Images
Copy Stamp ........................................ 1-12
Repairing ........................................ 1-11

D
Deleting Images .................................. 1-5
Displaying Images .................................. 1-3
Displaying Images in EOS Capture .............. 1-19
Displaying the Edit Image Window ............. 3-1
Displaying the Edit Window .............. 2-2
Displaying the Quick Check Window ............. 4-1

E
Edit Image Window .................................. 3-1
Edit Window .................................. 2-2
Editing Images .................................. 1-9, 2-6
Editing RAW Images .......................... 1-6, 2-3

F
Function Window Configuration ................. 0-3

G

H
Handling the Folders .......................... 1-4

I
Information Displayed with Images ............. 1-3

M
Main Features .................................. 0-2
Main Window .................................. 1-2

P
Printing Images .................................. 1-19
Printing with Easy-PhotoPrint ........ 1-19

Q
Quick Check Window ............................. 4-1

R
Reverting Edited Images to Their Original Condition
Reverting to Last Saved Settings ............. 1-14
Reverting to Shot Settings ............. 1-14
Rotating Images .................................. 1-2

S
Saving Edited Images ................................
Adding a Thumbnail of the Image ............. 1-14
Converting and Saving Images in a Single Operation (Batch-processing) ............. 1-16
Converting and Saving RAW Images while Renaming Them ............. 1-15
Saving and Renaming .................................. 1-14
Saving by Overwriting ............. 1-14
Selecting the Image Display Mode (Edit Window, Edit Image Window)

T
Tool Palette
RAW image adjustment tab sheet ............. 2-2, 3-1
RGB image adjustment tab sheet ............. 2-2, 3-1
Transferring Images to Image Editing Software
Transferring Multiple Images to Image Editing Software ............. 1-18
Transferring One Image to Photoshop ............. 1-18
Trimming Images .................................. 1-10
Trimming Window .................................. 1-10
Troubleshooting .................................. 5-1

U
Uninstalling the Software ................. 5-1
Using Edits (Recipe Data)
Copying Recipes and Applying to Other Images ............. 1-13
Loading and Pasting Recipes ............. 1-13
Saving the Recipes .................................. 1-13

Reference
Converting and Saving Images in a Single Operation (Batch-processing) ............. 1-16
Converting and Saving RAW Images while Renaming Them ............. 1-15

Appendices
Using Edits (Recipe Data) in the Quick Check Window
Adding a Thumbnail of the Image ............. 1-14
Converting and Saving Images in a Single Operation (Batch-processing) ............. 1-16
Converting and Saving RAW Images while Renaming Them ............. 1-15
Saving and Renaming .................................. 1-14
Saving by Overwriting ............. 1-14
Selecting the Image Display Mode (Edit Window, Edit Image Window)

Displaying the Edited Image and the Original at the Same Time ............. 2-3
Displaying the Grid lines ............. 2-3
Selecting the Display Size ............. 2-3, 3-1
Selecting the Image Display Mode (Main Window)
Displaying Image Information ............. 1-6
Displaying the Edit Image Window ............. 1-6
Displaying the Edit Window ............. 1-6
Displaying the Quick Check Window ............. 1-6
Image with Information Display ............. 1-5
Selecting the Thumbnail Size ............. 1-5
Sorting Images .................................. 1-5
Setting Picture Style
Adjusting the Hue, Saturation and Sharpness .................................. 2-6
Adjusting the Shadow and Highlight Points .................................. 2-6
Applying a Picture Style file ............. 2-5
Selecting a Picture Style .................................. 2-5
Selecting the Tone Curve .................................. 2-6
Shortcut Key List
Copy Stamp Window .................................. 5-3
Edit Image Window .................................. 5-2
Edit Window .................................. 5-2
Main Window .................................. 5-2
Quick Check Window .................................. 5-3
Trimming Window .................................. 5-3

Troubleshooting.................................. 5-1
Loading and Pasting Recipes ............. 1-13
Saving the Recipes .................................. 1-13

5-4